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Vegas Movie Studio   

 
The Vegas Movie Studio screen (Graphic User Interface) has 3 main areas; the track area, the 
timeline and the windows docking area. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
The ‘Track Area’ has 3 video tracks and 3 audio tracks.  A 4th video and audio track can be added 
from the ‘Insert’ menu. 
 
The ‘Windows Docking Area’ stores the ‘Explorer Window’, the ‘Trimmer Window’, the ‘Project 
Media Window’, the ‘Transitions Window’, the ‘Video FX Window’, the ‘Media Generators 
Window’, the ‘Mixer’ and the ‘Video Preview Window’.  These windows can be turned on and off 
from the ‘View’ menu. 

 
Clicking on the Tabs at the bottom of the ‘Windows 
Docking Area’ opens the required window. 
 

 
To undock a window, locate the 6 grey dots at the left 
hand side of a window and drag from here.  Hold the 
Control key down to prevent a window from docking. 
 
 

 
Click on the ‘Explorer’ Tab.  This opens up Windows Explorer and enables access to files stored on 
your computer and portable storage devices.  Turn on the ‘Auto Preview’ button on the toolbar to 
view or hear media.  The toolbar also has play and stop preview controls, folder options, view 
options, a web link button and a refresh button.  If you download media from the internet and can’t 
see it in the explorer window, click the refresh button.   
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Click on the ‘Rocket Launch’ clip and drag it to the beginning of track 3 then press play on the 
timeline transport bar.  The playback line will move across the clip denoting the place in time. 
 

 
 
 
 
 
 
 
 
 
 

 
Zooming  

 
The scroll wheel on your mouse can be used to zoom in and out of time.  The zoom in and out of 
time features can also be accessed by the controls at the bottom right of the timeline area.  The 
zoom in and out track height controls are also accessed here.   

 
Click in the timeline to give this area 
focus.  Zoom in time so that you can 
see some individual frames.   
Hold the mouse over the playback 
line to scrub through the clip. 
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The Mouse Cursor 

 
The cursor changes shape when held over different sections of a clip. 
   
A white arrow enables the clip to be moved along the timeline, or to be selected for editing or 
deletion.  A hand will appear if you hold the mouse at the top of a clip.  This enables the opacity 
levels to be edited.  Holding the mouse over the top corner of a clip produces an arched cursor and 
enables a fade in (left side) or fade out (right side) to be added.   Holding the cursor on the left or 
right edge of a clip produces a rectangle; the clip can be dragged out to repeat/loop (indentations 
show the repeat position) or dragged in to trim the clip. 

Add the ‘Moon’ clip and ‘Moon Walk’ clips to the timeline (track 3) to create cut shots. 
 

Clips can also be added by double clicking.  They will 
be added to the track that has focus, at the position of the 
playback line. 
 
 
 
 

Locate the ‘Automatic Crossfade’ button on the toolbar above the timeline area. 
Turn this button on (it should be turned on by default).  
 
Drag the ‘Moon’ and ‘Moon Walk’ clips to the left, so that the clips are overlapping, to create 
crossfades.  A time box (in seconds) will appear to show you the duration of the crossfade. 
A cross will appear on the overlapped section, the fade type can be changed by right clicking on the 
crossfade and selecting ‘Fade Type’ from the menu. 
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Transitions 

 
Transitions can be “dropped” on a fade or a crossfade.  Click on the ‘Transitions’ tab at the bottom 
of the ‘Windows Docking Area’.  A ‘Transitions’ category list will appear on the left hand side.  
Each category has transition presets that can be dragged onto a fade or crossfade.   
 

 
 

 
 

 
 
 
 
 
 
 
 
 

 
A transitions dialogue box will appear.  The transition can be edited here, close this dialogue box 
when finished.  To change a transition, drag a new preset on to the fade or crossfade.  To remove a 
transition or edit an existing transition, click on the ‘Transition Properties’ button on the clip (you 
may need to zoom in to see this button), right clicking on a clips crossfade will also enable access 
to the ‘Transition Properties’ dialogue box. 
 

 
 
 
 

 
 
 
 

 
The Auto Ripple Button 

 
 
It is sometimes necessary to move multiple clips to create room for additional media.  The ‘Auto 
Ripple’ button enables movement of all clips on a particular track or all clips on multiple tracks.  
The ‘Auto Ripple’ button is located next to the ‘Automatic Crossfade’ button.  The drop down 
menu next to this button has the track options.   
 
 
 
Turn this button on and then move the clips approx. 2 
seconds further along the timeline.  A box showing the 
seconds will appear at the top of the timeline. 
Turn the ‘Auto Ripple’ button off when you have 
completed this movement. 
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Adding Text 

 
Click on the ‘Media Generators’ tab at the bottom of the ‘Windows Docking Area’.  Select ‘Text’ 
from the category list.  The Presets with grey checks have an alpha layer/channel, this means they 
are transparent and can be used as a text overlay.  
 
Select a Preset with an alpha layer and drag it to the beginning of 
the text track (track 1).  NB all video tracks are identical; Movie 
Studio has labelled these tracks Text, Video Overlay and Video.  
Track titles can be changed by double clicking on the track name.   
 
A text dialogue box will open when you add a preset to the timeline.  The dialogue box has four 
tabs; Edit, Placement, Properties and Effects.  Edit will be open by default and is a word processor.  
Type in a title (if you can’t see your title in the Preview Window, place the playback line at the 
beginning of the text clip).  Select a font and font size. 

 
 
 
 
 
 
 
 
 
 

 
Click on the Placement Tab, the text position can be edited 
here.  Ensure that your text is within the ‘safe area’ (red 
square).  By default the safe zone is set to 10%. 
 
Click on the Properties tab, the text colour can be edited 
here.  Your Preset has a transparent background; a 
background colour could be added or edited here.  The 
Properties window also has tracking and scaling settings. 

 
 
 
 
 
 
 
 
 

 
Click on the Effects tab to add a Text Outline, Shadows 
and text Deformations.  Close the text dialogue box 
when you have finished.  If you need to return to this box for further editing, click on the clips 
green ‘Generated Media’ button (or right click on the clip and select Generated Media).  Shorten 
the length of your text clip and add a fade out. 
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Video FX 

 
Click on the Video FX tab at the bottom of the ‘Windows Docking Area’, single or multiple effects 
can be added to a clip from this window.  Click in the category list and select ‘Black and White’, 
and then drag the 100% Black and White Preset onto the ‘Rocket Launch’ clip.  A Video FX 
dialogue box will appear, close this box.  To re-enter this box for editing, click on the clips ‘Event 
FX’ button.  

 
Click on the ‘Remove Preset’ button in the ‘Event FX’ dialogue box to 
remove an effect. 
 
 
 

 
Playback Speed/Velocity 

 
The playback speed can be varied for scrubbing purposes.  To scrub through your movie at a faster 
rate, use the rate slider which is located at the top left hand side of the docking area.  To preview at 
a faster rate without scrubbing, drag the orange triangle to the right.  Double click on the orange 
triangle to return to normal playback rate. 

 
  
 
 

 
The velocity for an individual clip can be changed by holding down 
the ‘Control’ key and dragging a clip.  Dragging out will produce slow 
motion, dragging in will produce a faster motion.  The cursor will have 
a jagged line when you hold the ‘Control’ key down and hold your 
mouse over the edge of a clip.  To reverse the playback, right click on 
a clip a select ‘Reverse’. 
 
 

Audio 
 
The 3 audio tracks are labelled Voice, Music and Sound Effects.  The fourth audio track which can 
be added from the ‘Insert’ menu does not have a label.  The audio tracks are identical; track 
labels/titles can be edited. 
 
Click on the ‘Explorer’ tab and navigate to the Music Beds folder.  Select some music for your 
video and add it to an audio track.  Audio clip lengths are edited in the same manner as video.  
Adjust the length of your music to match your movie and add a fade in and fade out.  The volume 
can be changed using the track sliders. 

 
 To record from a microphone, click on the ‘Arm for Record’ 
button on an audio track, a volume meter will appear on the 
track.    
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Press record on the main transport bar to commence recording.  The first time you do this in a 
project, a dialogue box will appear which includes options for folder saving.  Click on the browse 
button to select a folder.  Press stop or the Space Bar when you have finished recording, a dialogue 
box will appear asking you if you would like to keep, rename or delete the recording, select ‘Done’ 
to return to the timeline. 
 

It is a good practice to rename audio clips as 
removing unwanted audio files from the hard drive 
will free up storage space.  This is a much easier 
process when files have descriptive names. 
 
Audio storage folders can also be selected from the 
‘File’ menu – Properties, then Audio tab.  Short cuts 
to the ‘Properties’ area are located at the top of the 
‘Mixer’ and ‘Video Preview’ windows. 
 
 
 
 

 
Opacity 

 
Whilst all video tracks are identical, tracks higher up in the track list have priority.  Click on the 
‘Project Media’ tab, this window is a library of media in use in your timeline and media you may 
have deleted from the timeline. 
 

 
 
 
 
 
  
 
 
 
 
 
 

 
Drag the ‘Moon’ clip from the ‘Project Media’ window and place it on track 2, on top of the 
‘Moonwalk’ clip.  The ‘Moonwalk’ clip will now be hidden as track 2 has a higher priority.  The 
opacity level can be changed for an individual clip or for the entire track. 
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‘Composite Level’ envelopes can also be used to vary the opacity.  Put the clip and track opacities 
back to 100%.  Go to the ‘Insert’ menu and select ‘Video Envelopes’, then select ‘Track Composite 
Level’.  A blue line will appear across the track.  Double click on this line to create ‘Points’; 
individual points can then be edited by dragging.  Right clicking on a point will bring up a point 
menu. 
 

To remove the envelope, go back to the 
‘Insert’ menu and uncheck the 
envelope.  To hide the envelope, go to 
the ‘View’ menu, select video 
envelopes and uncheck ‘Composite 
Level’ (all envelopes can be hidden 
from this menu by turning off ‘Show 
Envelopes’).  Envelope settings can also 
be accessed using the ‘Envelope Edit 
Tool’ (on the main toolbar).  Right click 
in the timeline with this tool to insert 
and show envelopes. 
 

 
 

‘Picture in a Picture’ Effect 
 

Remove the composite envelope from your ‘Moon’ clip on track 2.  You are now going to resize 
the ‘Moon Clip’ and position it in the top right hand corner.  There are two ways of doing this; on 
the individual clip using the ‘Event Pan/Crop’ features, or for the entire track using ‘Track motion’. 
 

Click on the ‘Event Pan/Crop’ button on the ‘Moon’ clip. 
 
The ‘Event Pan/Crop’ window will 
open.  Use the Scroll Wheel on your 
mouse to zoom in and out. 
 
 
 
 

 
 

 
 
 
 
 
 
 
 

‘Cookie Cutter Presets’ are available from the ‘Video FX’ list.  These Presets can be edited to 
obtain a variety of ‘Picture in Picture’ effects. 
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Solo and Mute Buttons 

 
Each video and audio track has a mute button and a solo button. 

 
 
 
 
 
 
 
 
 
 

 
Looping 

 
Small or large sections of the video can be set to loop.  Double Click on a clip to select a loop 
region.  Double click on the top of the timeline to select larger regions.  Turn on the loop button on 
the main transport bar. 
 

Splitting Clips 
 

To split a clip, click on the desired split point of 
the media.  The playback line will move to this 
position, then press ‘S’ on your computer 
keyboard.  Hold the ‘Control’ key down to select 
multiple tracks for splitting (click away from the 
playback line for subsequent selections when 
‘Control’ clicking).  The ‘Selection Edit Tool’ 
could also be used for multiple selection; draw 
around the required clips with this tool. 

 
 
 
 

 
The Trimmer 

 
Clips can be trimmed by dragging the edges in the timeline; they can also be edited in the 
‘Trimmer’.  Right click on the clip in the timeline, ‘Explorer’ or ‘Project Media’ windows and 
select ‘Open in Trimmer.  Use the Trimmer playback line to scrub through the clip or press ‘Play’ 
on the Trimmer transport bar.  Determine ‘In’ and ‘Out’ points; Press ‘I’ on your computer 
keyboard for in and ‘O’ for the out, your selection can then be added to the timeline using the arrow 
buttons on the transport bar. 
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Adding a Credit Roll 

 
Click on the ‘Media Generators’ tab and select ‘Credit Roll’ from the category list.  Drag a preset 
onto a video track, at the end of your movie. 
 
Type in your text.  Additional lines can be added, click in the column area to select a ‘Header’, 
single or double column. 

 
 
 
 
 
 
 

The Properties area in this dialogue box can be used to select ‘Scrolling Credits’ or ‘Timed 
Sequences’.  Scrolling and placement options can also be edited here.   

 
 
 
 
 
 
 
 
 
 

 
Click on the ‘Styles’ tab to access the word processing features.  The amount of space between 
each line can also be adjusted here.  

 
 
 
 
 
 
 
 
 
 
 

 
These supplementary training notes for session 1 of the Teacher Professional Learning day at 
Soundhouse™@Chatswood, Chatswood High School, may be reproduced in printed or digital form for 
educational purposes. 
 
Briona Gill 
Soundhouse™@Chatswood 
  
Sony Media Software has given permission for participants at Soundhouse™ training courses, to use the 
three video clips; ‘Rocket Launch’, ‘Moon’ and ‘Moonwalk’ for educational purposes at their schools 
throughout 2007.  These videos are not to be redistributed or sold.  
 
Akiko Kubo 
Sony Media Software 


